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CHAPTER 1

Welcome to Parallels Toolbox

Parallels Toolbox is a collection of convenient, easy-to-use, lightweight applications, or tools, to
help you focus, manage time, get things done, and stay secure. It provides quick access to many
common functions that are either hidden, require hard-to-remember keyboard shortcuts, or are just
not available.

|| Parallels

With Parallels Toolbox, you can;

= Take screenshots or record video of any part of your screen, any window, or your full screen
= Take screenshots of entire web pages even if they are not fully displayed on the screen
= Resize images and convert them to a different format

= Prevent your Mac from going to sleep so you can be sure an important task won't be
interrupted

= Quickly disable distracting notifications so you can focus on the task at hand

= Simultaneously gject all volumes and removable media from your computer

« Open several predetermined applications or documents at once

= Hide all the items on your desktop with one click, for clean presentations or screenshots

= Record audio from your computer's microphone, and record video or take pictures from your
computer's camera

= Block your computer's microphone or camera to prevent unauthorized recordings

= Lock the screen with a single click to prevent access without a password

= Easily download video from many popular Internet video sites

= Easily download audio files or playlists from the Internet

= Convert video for playback on your iPhone or iPad, and transfer it to iTunes for easing syncing

= Set an alarm, a countdown to a specific date, a stopwatch, or a timer
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Create archives from multiple files to save space or easily share. And you can password protect
them for security.

Unpack archives encoded in various formats

Make GlFs from video files

Find and delete duplicate files

Get more free space and optimize your Mac by deleting unnecessary files

Release inactive memory and optimize memory consumption on your Mac

Easily change the screen resolution

Quickly turn off all wireless communication (Wi-Fi, Bluetooth, etc.) on your Mac

Minimize various distractions when showing a presentation

Show and conceal hidden files

Completely uninstall applications and remove leftover files of the previously deleted applications

Check local time and time offset information in thousands locations around the globe

The Toolbox is just one click away in the menu bar, and tools can also be launched from the Finder
or from the Dock.

In This Chapter
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Installing Parallels Toolbox

If you install or upgrade to Parallels Desktop 12 or later, you'll be prompted to install Parallels
Toolbox.

Otherwise, you can download Parallels Toolbox from www.parallels.com/toolbox.

To install Parallels Toolbox:
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1 Open the image file you downloaded and double-click Install Parallels Toolbox.

®0e .| Parallels Toolbox

Parallels Toolbox
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Install Parallels Toolbox

Parallels Toolbox is installed in your Applications folder and is immediately ready to use. To get
started, just click B in the menu bar at the top of your screen.
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If necessary, sign in to your Parallels account. Or create a new one if you don't have one
already.

I &= «) B3 [ Wed14:55

Parallels Toolbox
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Using Parallels account:

© 1 am a new customer
| have a password:

Forgot password? m

With social media account:

Note: If you have Parallels Desktop, you may not need to sign in.



CHAPTER 2

Basics

In this section learn the basics for accessing all the tools in Parallels Toolbox.
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Open a tool

Click =4 in the menu bar at the top of your screen to open the toolbox and then click the tool you
want.

Q Parallels Toolbox

Favorite & Recent

Library
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Archiver Camera Record Screen Take
Screenshots
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Airplane Mode Clean Drive  Convert Video Do Not Do Not Sleep
Disturb
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Audio Video Duplicates
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Hidden Files  Hide Desktop Launch Lock Screen Make GIF
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Mute Presentation Record Audio Resize Images Switch
Microphone Mode Resolution

Uninstall Apps
Tips and Tricks

Drop a link to video on the internet to "Download Audio” and it will retrieve
audio from that file
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Basics

Tips: Some tools start working as soon as you open them. For example, when you open the Record
Audio tool a recording starts right away.

You can also activate some tools, such as Archiver or Download Video, by dragging files or other
objects onto them. See the instructions for each tool (p. 14) for more information.

Quickly access the tools you use most

You can put the tools you use most in easy-to-access places so you can find them even more
quickly and conveniently. Just click B in the menu bar and drag a tool to place it where you want
it.

You can drag tools to:

e The Dock at the bottom of the screen

o Vs

= The menu bar at the top of the screen
O im & %

= The Favorite & Recent area at the top of the toolbox

% = I B Sun11:18 AM
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This area also shows the five most recent tools you've used.

Tip: To remove a tool from the Dock or Favorite & Recent area, just drag it out. To remove a tool from
the menu bar, hold down the Command key on your keyboard and drag the tool out.

See whether a tool is active

By looking at a tool's icon in the Dock, menu bar, or Favorite & Recent area in the toolbox, you
can see whether it's active and sometimes see other information about its state.
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For example, below the Record Window icon is blinking red to show a window is being recorded,
and the Timer icon shows how much time is left.

Parallels Toolbox o

[ 01:41:30

Record Timer
Window

Change a tool's settings

Many tools have settings you can change. For example, in tools that record audio you can set the
sound source.

To access a tool's settings, do one of the following:

e Click B in the menu bar, then right- or Control-click the tool and choose Preferences.

« In tools that have windows, open the tool and click % in the window.

Tip: Notifications let you know when a tool needs your attention. You can disable (or re-enable)
notifications for any tool in System Preferences > Notifications.

Quit Parallels Toolbox

By default, Parallels Toolbox is always available in the menu bar. You can quit Parallels Toolbox by
doing the following:

1 Click B in the menu bar.
2 Click 3¢ and click Quit Parallels Toolbox.

Note: Some tools, such as Timer and Stopwatch, stop working when Parallels Toolbox isn't running.

11



CHAPTER 3

Parallels Toolbox Preferences

This section describes what you can do in Parallels Toolbox preferences. To open the preferences:
Click =4 in the macOS menu bar.

2 Click % and select Preferences.

In This Chapter
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General

On the General tab, you can do the following:

= choose whether Parallels Toolbox starts together with your Mac;
= disable automatic updates; and
= choose whether the "Tips and Tricks" section is available in the Parallels Toolbox window.

Shortcuts

On the Shortcuts tab, you can create keyboard shortcuts to launch tools.

To create a shortcut, do the following:

1 Click "+" at the left bottom corner of the window.
Select a tool from the Tool menu.

Click the Keyboard Shortcut field and press the key combination you want to use to launch
the selected tool.

4 Click Add.
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Tools

On the Tools tab, you can choose which tools are displayed in the Parallels Toolbox window.
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CHAPTER 4

The Tools

This section has instructions for using each of the tools in Parallels Toolbox.

In This Chapter
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Images, Audio, and Video

Parallels Toolbox offers tools for taking screenshots, recording video of what's on your screen,
taking photos, recording audio and video using your computer's camera and microphone, and
downloading and converting video.

TAKING SCREENSHOTS

The four tools below help you capture images of whatever is on your screen. This can be helpful,
for example, if you need technical support and want to send someone an image to show them
what's happening on your screen, if you want to save a record of something, or if you're putting
together a presentation.

Tip: Press and hold the Control key while taking a screenshot to copy it to the clipboard.

To access these tools, click Bk in the menu bar, click Take Screenshots, and then click the tool
you want.

By default, all these tools save screenshots on the desktop. If you want to change the default
location, right-click any of the tools, select Preferences and specify another location.

If you use the Capture Area, Capture Screen and Capture Window tools, you can choose to take
screenshots with a delay. Right-click any of the tools, point to Run with delay and specify the time
interval you need.
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When you take screenshots using Capture Area, Capture Screen and Capture Window, the default
file format is PNG. You can change the default format to JPEG, TIFF, PDF or GIF. Right-click any of
these tools, select Preferences and choose the format you need from the Image format menu.

If you're working in macOS 10.14 Mojave, you can choose to show a floating thumbnail once a

screenshot is taken. To do so, right-click Capture Area, Capture Screen or Capture Window, select
Preferences and make sure Show Floating Thumbnail is selected.

Capture Area

Use this tool to take a screenshot of a part of the screen.

1 Open the tool, then click and drag to highlight the area you'd like to capture.
You can adjust the selection by dragging the corners.

2 Then click inside the selection box to take the screenshot.

Capture Screen

Use this tool to take a screenshot of the entire screen.

= QOpen the tool, then click anywhere to take the screenshot.

If your Mac has more than one display, click the screen you want to capture.

Capture Window

Use this tool to take a screenshot of a single window.

« (Open the tool, then click any window to take the screenshot.

Screenshot Page

Use this tool to take a screenshot of the entire web page even if it's not fully displayed on the
screen.

Note: This tool is currently unavailable in macOS 10.14 Mojave.

15



The Tools

« (Open the tool.

If you open it for the first time, you will be asked to install a special extension for the Safari web
browser. This extension adds a button to the left of the Safari address bar. Click this button to
make a screenshot of the currently displayed web page. You can choose whether you want to
take a screenshot of the whole web page or only of its visible part.

SCREEN RECORDING

The three following tools let you record a video of whatever is happening on your screen. You can
record a single window, a selected area, or the full screen.

Set the audio source

As you record video using any of the tools below, by default audio is also recorded from whatever
input source your Mac is set to use (usually the built-in microphone), so you can narrate the video if
you like.

You can set the tool to record from a different source, including:

= Another microphone connected to your computer
« System audio, so the sounds from your computer are recorded

Note: The first time you set a tool to record system audio, you are prompted to install a sound driver
and restart your computer. Just follow the onscreen prompts.

< No sound, for a silent video
To set the audio source:

1 Click i in the menu bar, right- or Control-click the tool, and choose Preferences.

2 Choose a source from the Audio source pop-down menu.

Videos are recorded in .mov format, for easy playback.

To access a screen recording tool, click Bk in the menu bar, click Record Screen, and then click
the tool you want.

By default, all these tools save videos on the desktop. If you want to change the default location,
right-click any of the tools, select Preferences and specify another location.

You can also choose to start recording videos with a delay. Right-click any of the tools, point to
Run with delay and specify the time interval you need.

16



The Tools

If you're recording a tutorial or some educational video and need to show mouse clicks, right-click
any of the tools, select Preferences and choose Highlight mouse clicks.

You can also choose the video resolution between original, medium and small. Right-click any of
the tools, select Preferences and select the resolution you need from the Resolution menu. The
smaller the resolution - the smaller the file size.

Record Area

Use this tool to record video from a selected area of your screen.

1  Open the tool, then click and drag to highlight the area you'd like to record.

You can adjust the selection by dragging the corners.

Tip: If you change your mind and don't want to record, you can press the Esc key to cancel.

2 To start the recording, click inside the selection box.

The Record Area icon appears in the Dock and flashes red to confirm you are recording.

©

3 To stop recording, click the Record Area icon in the Dock.

Record Screen
Use this tool to record video of your entire screen. When activated, click anywhere to start

recording. If your Mac has more than one display, click the display you want to record from. To
stop recording, click the Record Screen icon in the Dock or in the menu bar.

Record Window

Use this tool to record video from a single window.

1 Open the tool, then click any window to begin recording.

The Record Window icon appears in the Dock and flashes red to confirm you are recording.

17



The Tools

2 To stop recording, click the Record Window icon in the Dock. The video file appears on
your desktop.

Record Audio

Use this tool to record audio from your computer's built-in microphone.

1 To start a recording, just click Record Audio in the Parallels Toolbox window.
The blinking icon in the Dock lets you know that audio is recording.

2 To stop recording, click the tool's icon again (in Toolbox or in the Dock). By default, Record
Audio saves recordings to the desktop. If you want to change the default location, right-click
the tool, choose Preferences and specify a new location.

Clicking the icon again starts a new recording to be saved as a new file.

Tips: In the Record Audio preferences, you can choose the sound format and from which microphone
sound is recorded.

You can also choose the file size of your recordings. Please note, the smaller the file size - the lower the
quality.

To access the preferences, right-click Record Audio and select Preferences.

TAKING PHOTOS AND VIDEO

You can use the following tools to quickly take a picture or video with your built-in or connected
camera.

To access these tools, click & in the menu bar, click Camera, and then click the tool you want.

Take Photo

Use this tool to take a picture using your computer's built-in camera.

= Open the tool. A preview appears. Click the camera button to take a picture.
By default, an image file appears on the desktop. To change the default location, right-click the
tool, select Preferences and specify another folder.

Note: If your Mac has two or more cameras, right-click the tool, select Preferences and choose the
camera you want to use from the Camera menu.

18
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You can set Take Photo so that it takes a picture immediately when you open it, instead of
showing a preview.

1 Open Take Photo and click %.

2 Deselect Show Preview.

Tip: If you disable showing a preview, you can access Take Photo settings again by clicking '@ in the
menu bar, Control- or right-clicking the tool, and choosing Preferences.

Take Video

Use this tool to record video using your computer's built-in camera. As you record video, audio is
also recorded from your computer's microphone (by default).

Open the tool. A preview appears. Click the camera button to start recording.
2 When you're finished recording, click the stop button.

By default, a video file appears on the desktop. To change the default location, right-click the
tool, select Preferences and specify another folder.

Videos are recorded in .mov format, for easy playback.

Note: If your Mac has two or more cameras, right-click the tool, select Preferences and choose the
camera you want to use from the Camera menu.

You can set Take Video to record from a connected microphone or to not record sound. To
change the audio source:

1 Click B in the menu bar, right- or Control-click the tool, and choose Preferences.
2 Choose a source from the Record audio from pop-down menu.

You can set Take Video so that it starts recording immediately when you open it, instead of
showing a preview.

1 Open Take Video and click %¥.

2 Deselect Show Preview.

Tip: If you disable showing a preview, you can access Take Video settings again by clicking B4 in the
menu bar, Control- or right-clicking the tool, and choosing Preferences.

ONLINE VIDEO

You can quickly and easily download video from your favorite video websites, and you can convert
video for use on your iPhone, iPad, or iPod.

19
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Download Video

Use this tool to download videos from the Internet. Many popular video sharing sites are supported.

« QOpen the tool. If you open it for the first time, you're asked to enable a special extension for the
Safari web browser. This extension adds a button to the left of the Safari address bar. Use this
button to download the video from the currently opened web page.

By default, videos are saved to the Downloads folder. To change the default location, right-click
the tool, select Preferences and specify another folder.

To manage file sizes or time taken to download a video, you can set the maximum resolution to
download. To do so:

1 Open Download Video and click % in the upper-right corner.
2 Choose a maximum resolution from the Preferred quality pop-down menu. You can choose:
e Low (up to 360p): The fastest to download.
< Normal (up to 720p)
= High (up to 1080p)
< Max (maximum available): Up to 4k

Your choice is saved for subsequent downloads.
You can also choose what to do with non-MP4 videos:

1 Open Download Video and click % in the upper-right corner.
2 Choose one of the following from the For non-MP4 videos menu:

= Download MP4 in lower quality. If the tool downloaded a non-MP4 video in the selected
quality but failed to convert it to MP4, select this option and try to download this video again.
The tool will try to find it in a lower quality but in the MP4 format.

< Download without conversion. The tool will not convert non-MP4 videos to MP4.

= Convert to MP4. Once a non-MP4 video is downloaded, the tool will try to convert it to
MPA4.

Tip: You can download several videos simultaneously using the Download Video tool.

Convert Video

Use this tool to convert videos so they can be played in the Video app on an iPhone or iPad. The
tool can convert almost any video format.

20
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1 Open the tool. A window appears.

2 Drag a video, for example your favorite movie or TV show, to the window and it is converted. By
default, the converted video appears in the same folder is the original.

You can also use Convert Video to optimize video for playback on your iPhone, iPad, or iPod. Then
you can use iTunes to send the video to your device. To do so:

1 Open Convert Video and click % in the upper left corner of the window that appears.
2 Choose iTunes from the Save video to pop-down menu, and click Done.

This setting is saved for subsequent conversions unless you change it.
3 Drag a video to the window to convert it.

The video appears in iTunes under Movies > Home Videos.

4 Be sure your device is connected to your computer, then right-click or Control-click the video in
iTunes and choose Add to Device > [your device].

To manage file sizes, you can set the maximum resolution to convert a video to. To do so:

1 Open Convert Video and click %.

2 Choose a maximum resolution from the Video quality pop-down menu. You can choose:
< Normal (up to 720p)
< High (up to 1080p)

Subsequent videos are converted at the resolution you choose.

Download Audio

Use this tool to download audio files from the Internet. You can download audio files one by one or
the whole playlist at once. Or you can download audio from a video file.

To download an audio file:

1 Launch Download Audio from the Parallels Toolbox window.
2 Do one of the following:

= To download an audio file, drag the link to the audio to the tool's icon in the Dock or to the
tool's window. You can also right-click an audio, select Copy Link, then click the tool's
window and press Command + V.

= To download a playlist from a webpage, drag the page URL (from the browser address bar)
to the tool's window or icon.

= To download audio from a video file, drag the video file URL to the tool's window or icon.

21
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Note: By default, audio files are downloaded to your Downloads folder. To change the default location,
right-click the tool, select Preferences and specify another folder.

Make GIF
Use this tool to create animated GIF files from videos.

Before you start creating a GIF, you may want to change the GIF file settings such as size and
frame rate. Right-click Make GIF in the Parallels Toolbox window, click Preferences and choose
the size and frame rate you need from the corresponding menus.

To create a GIF file, do the following:

1 Launch Make GIF from the Parallels Toolbox window.
2 Do one of the following:
= Drag some video to the tool's window.

= Move the mouse pointer to the tool's window, click Open and select the video from which
you're going to create a GIF file.

22
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Choose your start and end points.

o0 Make GIF T

— = Caption: al Make GIF
|| Parallels
Note: To set the start and end points more accurately, you can use the slider that allows you to zoom
in the timeframe.

4 Set how you want to play the frames. You can choose between Normal, Reverse and Back
and Forth.

If you want, add some caption to the corresponding field.

Click Make GIF to create a GIF file. The resulting GIF file is saved to the same folder where the
original video is located. If you want to change the default location, you can do this in the tool's

preferences.

Resize Images

Use this tool to resize images or convert them to a different format.

23
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Launch Resize Images from the Parallels Toolbox window.
2 Drag a picture (or a group of pictures) to the Resize Images window.
Do the following:
= |f you want to change the file format, select the format you need from the Format menu.

= If you want to resize the picture, specify another width and hight in the corresponding fields.

Resize Images
Format:

;é. PT_toolbox_15.png Original E

Width:
908

Height: ("
1654

Resulting Size:
Images: 1
1,6 MB (was 1,6 MB)

Drop or open images you want
to resize

|| Parallels Resize

Note: Use the Lock icon to constrain proportions.

4 Click Resize. By default, the resulting file or files are saved to the Desktop. To change the
default location, right-click the tool, select Preferences and specify another folder.

Focus and Time Management

Parallels Toolbox can help you stay on task and get things accomplished by minimizing
distractions, getting your computer ready for presentations and other tasks, and keeping track of
important events and deadlines.

FOCUS

These next few tools are for when you want to make sure there's nothing to distract or interrupt
you or others from your work.

24
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Do Not Sleep

When activated, this tool prevents your Mac from going to sleep and your display from dimming.
This is useful when you want to ensure a task won't be interrupted.

= To prevent your computer from sleeping, simply open this tool. All settings that would allow the

computer go to sleep are disabled.

To deactivate this mode and restore all sleep settings, simply launch the tool again.

By default, when you turn on Do Not Sleep your computer is set not to sleep until the end of the

day, at 12:00 a.m. You can choose another setting for how long your computer is prevented from

going to sleep:
1 Right-click Do Not Sleep and select Preferences.

2 Choose for how long your computer is prevented from going to sleep.

Tips: Use the Do Not Sleep tool when you need the computer to remain active and accessible, for
example, if you plan to access it remotely.

Drag the Do Not Sleep tool to the menu bar or Dock so you can see the current status. If the icon is red,
then your computer is set not to sleep.

Do Not Disturb

Use this tool to quickly disable all notifications so you can focus on the task at hand.

= To turn on Do Not Disturb mode, simply open this tool.
Do Not Disturb turns off automatically at 12:00 a.m.

To turn off this mode, launch the tool again. All previous notification settings are restored.

Tip: Do Not Disturb mode is useful when giving a presentation or recording onscreen video.

Hide Desktop

Use this tool to hide all the files, folders, and other icons on your desktop.

= To hide everything on your desktop, simply open this tool.

To show the icons again, click the tool again.

25
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Tip: The Hide Desktop tool is useful when, for example, you're doing a presentation, taking
screenshots, or recording your screen.

Presentation Mode

Use this tool when showing a presentation. When Presentation Mode is on, the macOS
notifications and animations in the Dock are disabled, the Mac is prevented from going to sleep,
and the files on your desktop are hidden.

Notes:

1. When you connect an external display, Presentation Mode may turn on automatically.

2. You can edit the Presentation Mode settings (for how long the presentation mode is on, whether the
mode turns on automatically, whether the naotifications and animations are disabled, etc.) according to

your preferences. To edit the settings, right-click Presentation Mode in the Parallels Toolbox window and
choose Preferences.

Airplane Mode
Use this tool to quickly turn off all wireless communication (Wi-Fi, Bluetooth, etc.) on your Mac.

To activate the airplane mode, simply click the Airplane Mode icon in the Parallels Toolbox window.
To disable the airplane mode, click this icon again.

TIME

The following five tools can help you keep track of time sensitive tasks or events. To access these
tools, click B in the menu bar, select Time, and then click the tool you want.

Alarm

Use this tool to alert you at a specific time with a notification and a repeating sound.

1 To set the alarm, right-click the Alarm tool, select Preferences and set time and day of the
week (or several days of the week).

26
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2 Choose an alarm sound from the Sound pop-up menu. Or you can use any sound file by
choosing Choose file and selecting the file.

3 Click Done and click the switch to turn the alarm On.

The alarm will go off as scheduled, even if the tool is not open, and will repeat each week
unless you change the schedule or turn it off.

When the alarm goes off, you're prompted to turn it off. Or you can click the Snooze button to
be alerted again in 5 minutes.

Date Countdown

Use this tool to set up a countdown to a specific date, such as a birthday, a deadline, or a
vacation.

1 To set a date to count down to, open the tool and click ¢ in the upper-right corner of the tool
that opens.

2 Enter the date, and enter a title for the event.

If you like, select Repeat every year. The day after the event, the countdown will start again for
the same date the next year.

3 Click Done. Date Countdown starts counting down the days.
When the date arrives, a message is displayed.

4 If you want to see the count down each day, place Date Countdown in the Dock (p. 8). The
number of days remaining in the countdown are shown in the icon in the Dock.

Tip: Date Countdown continues its countdown even after you restart your computer.

Stopwatch

Use the Stopwatch tool to measure elapsed time, as you would with any stopwatch. You might
use it, for example, to measure how long it takes to perform a certain action on your computer.

= To use the Stopwatch tool, open it and click Start. Click Stop to stop, and click Reset to reset
the timer.

Timer

Use the Timer to count down from a time you specify to zero.

27



The Tools

= To begin a countdown, open the tool, enter a time and click Start.

Even if you close the application, it continues counting down and notifies you when the timer
reaches zero.

To set which sound plays when the timer reaches zero, click % in the upper-right corner and
choose a sound.

"

Timer

00nh O3m 00s

Start

Reset

World Time

Use this tool to see local time and time offset information in thousands of cities located in different
time zones.

To select where you want to see the time, right-click the tool, select Preferences and start typing
the name of the city. When this city pops-down, select it. You can add as many places as you
need. To change the order in the list, simply drag the cities up or down. Once ready, click Done.

The tool's icon will appear in the macOS menu bar. Click this icon to see the local time and time

offset info in the selected locations. You can choose how the menu bar icon looks like - open the
tool's preferences and select the way you need from the Menu bar menu.
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Il @t LS ) B3 @ Wed

New York, NY, United States g.01 '
Today, 8 hours behind 08:01 ﬁ

~ Brno, Czechia
Today, 2 hours behind

14:01 Lf

13:01 %

London, United Kingdom
Today, 3 hours behind

Tokyo, Japan .
Today, 6 hours ahead 22:01 Q::’

Preferences...

Quit

Note: To use World Time, your Mac must be connected to the Internet.

Switch Resolution

Use this tool to quickly change the screen resolution on any display connected to your Mac.

When you launch Switch Resolution, its icon appears in the macOS menu bar. To change the

screen resolution, click this icon and choose the resolution you need.

W ) 4 & mmag3ce || LB ) @ Mon 22:53
Built-in Retina Display (This display)
1680 x 1050 (retina) >

Default for display

3840 x 2400
3360 x 2100
2880 x 1800
2880 x 1620
2560 x 1600
2560 x 1440
2048 x 1280
1920 x 1200 (retina)
1920 x 1200
1920 x 1080
v 1680 x 1050 (retina)
1680 x 1050
1650 x 1050
1440 x 900 (retina)
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Security and File Management

Parallels Toolbox can help keep your computer, your files, and your environment safe and private.
You can also use it to simplify file-management tasks; for example, you can open multiple files or
other items at once, eject multiple volumes, create an archive with multiple files (password-
protected if you like), and unarchive files that someone else sent.

Lock Screen

Activate this tool to immediately lock your screen to prevent unauthorized access to your computer.
No need to wait until the password-protected screen saver kicks in, or to remember which corner
activates what — simply click the Lock Screen tool.

To unlock the computer and continue, just enter your user account password.

Tip: For a convenient way to lock your computer's screen with just one click, place the Lock Screen tool
in the Dock. Just click ™ in the menu bar and drag Lock Screen to the Dock.

Mute Microphone

Use this tool to mute your computer's microphone to prevent unauthorized listening by other apps.

< To mute the microphone, just open this tool. The built-in microphone is muted and no app
receives input from the microphone. The tool's icon indicates that it's active and that the
microphone is muted.

To disable muting, click the icon again.

Tip: When active, the Mute Microphone tool warns you if another application tries to unmute the
microphone, and prevents the app from doing so.

Block Camera

Use this tool to block your computer's built-in camera to prevent recording by other apps.

1 Click & in the menu bar, click Camera, and then click Block Camera.

2 If prompted, click Restart to restart your computer. You only need to restart your computer the
first time you use the tool.
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3 Restart any apps that may have been using the camera.

The camera is blocked and no app receives input from it. The tool's icon indicates that it's active
and that the camera is inoperable.

To re-enable the camera, open the tool again.

Tip: When active, the Block Camera tool warns you if another application tries to turn the camera back
on, and prevents the app from doing so.

Launch

Using the Launch tool, you can specify a set of documents and applications to open all at once.
This can help save time if your workflow requires opening the same items repeatedly.

To use this tool:

1 Open the tool and drag files and apps to it that you want it to open. Or click Open and choose
items.

To remove an item, click X next to it.

2 To open the set of items, click Launch or open the tool again.

Tip: To change which files and apps this tool opens, right-click or Control-click the tool and choose
Preferences.

Eject Volumes

Use this tool when you want to quickly eject and unmount all volumes connected to your computer,
including things like external hard drives, USB drives, network volumes (SMB, AFP, etc.), and disk
images (DMG, ISO, etc.).

= To gject all volumes, just open the tool.
To choose which types of volumes eject:

1 Right-click or Control-click the tool and choose Preferences.

2 Deselect volume types that you don't want to eject when you use the tool. Volume types
include:

« External volumes: Hard drives, USB drives, etc.
< Network volumes: SMB shares, AFP shares, etc.

= Local volumes: Mounted disk images (DMG, ISO, etc.)
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Eject Volumes doesn't gject your startup disk.

Archive

Use Archive to create a compressed archive from multiple files. This can save space, and you can
easily share the archive with friends or colleagues.

Tip: Unlike the built-in OS X compression utility, Archive lets you archive files from multiple locations
without having to move them to the same folder, and you can password-protect your archive for greater
security.

To create an archive of multiple files:

Click 4 in the menu bar, click Archiver, and then click Archive.
2 Either drag files to the window that opens, or click Open and select a file you want to archive.
To add more files, drag them to the window, or click Add and select more files.

3 Ifyou'd like to password-protect the archive, click ¥, select Protect by Password, and enter a
password.

"

Archive

':'_"i Screen Shot 2...
'—'G Screen Shot 2...

=% Screen Shot 2...

Archive

Be sure to let anyone who you want to have access to the files know the password.

Tip: Unless you change the password or deselect the option, subsequent archives you create will use
that password.

4 Click Archive. The archive file is saved in the same location as the first file in the archive.

Tip: You can create archives by dragging files and folders to the Archive icon in the Dock.
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Unarchive

Use this tool to unpack archives, including those not supported by the built-in compression utility.
For example, this tool can unpack archives formatted as 7z, RAR, RPM, XAR, and Z.

To unpack an archive, click B4 in the menu bar, click Archiver, and then click Unrchive.
2 Either drag an archive to the window that opens, or click Open and select an archive.

Unarchive also supports password-protected archives. When you attempt to unarchive a
password-protected archive, you are prompted to enter a password.

Tip: Make Unarchive the default app to unpack supported archives by setting them to be so in Finder's
Get Info dialog. Then you can just double-click an archive to unpack it.

Hidden Files
Use this tool to show and conceal files that are usually hidden in macOS.

To show hidden files, click the tool in the Parallels Toolbox window. To conceal hidden files, click
the tool again.

Uninstall Apps

When you remove some applications,they may leave various files on your Mac. Use Uninstall Apps
to completely remove applications that you no longer use as well as leftover files of the previously
deleted applications.

1 Click Uninstall Apps in the Parallels Toolbox window.
2 Select whether you want to remove Apps or Leftovers.

3 Do one of the following:
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= If you want to delete an application, select it in the list and click Uninstall.

Uninstall Apps
Microsoft Word.app 633 MB
Q Apps E [Applications/Mierosaft Office 2011

\ Microsoft Word com.microsoft Word.plist 4KB
63,3 MB
4 [Users/parallels/Library/Preferences

Microsoft Excel
55,3 MB

% Microsoft Outlook
% s31m8

Micrasoft PowerPoint
34,2 MB

Microsoft Chart Converter
26 MB

Microsoft Query

td
W gome
e Total size: 63,3 MB [ Uninstall |

= [f you want to delete leftover files, select them and click Clean.

Optimization

Parallels Toolbox can help you to optimize your Mac by deleting unnecessary files (duplicate files,
temporary files, cache files, etc.).

Clean Drive

Use Clean Drive to get more free space by deleting unnecessary files like cache, logs, temporary
files, etc. To clean up your Mac:

1 Launch the tool. Clean Drive scans your Mac and calculates how much space can be freed up.
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2 Select the categories of files you want to delete and click Clean Up.

() Clean Drive *

0,25 GB

Ready for Cleanup

Log files
[/ Cache files
Trash
Browser data
Mail cache
Mobile apps
iTunes temp files
iOS device backups
Old updates

Clean Up

Show Large Files...

|| Parallels

You can also use Clean Drive to delete your old and large files. Do the following:

1 Launch Clean Drive and click Show Large Files at the bottom of the tool's window. A new
window opens. In this window, all your files are sorted out by size.

2 Right-click the file you want to delete and select Move to Trash.

e @ &1 1DDACBB9-4F97-4AB5-A694-36BASF6754
N =m o = #Hv

| Eavorties From 100 GBto 1 T8
Pictures
n Music =! 1
g . Open
& iCloud Drive Open With .
[ Desktop i Show in Enclosing Folder
Bl Movics Show Package Contents
From 1
@) AirDrop Move to Trash
£ Recents Get Info
¥ Applications || Rename
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Find Duplicates

Use this tool to find and delete duplicate files on your Mac.

1

2 For each detected duplicate, select the copies you want to delete and click Move to Trash.

Launch Find Duplicates and do one of the following:

= Drag one or more directories you want to check for duplicates (for example, your

Documents and Downloads folders) to the tool's window.

= Move the mouse pointer to the tool's window, click Select and choose the directories you

want to check for duplicate files.

Find Duplicates scans the folders you chose and shows the list of detected duplicate files. In

this list, you can see how many duplicates and their copies have been detected.

1

2

: 3l

Note: You can use the menu at the top of the list to sort the files by name, size, type, or to show only
some particular type of files.

Find Duplicates

vm_configuration_webandema
Copies: 2 Size: 80 KB

vm_configuration_webandema
Copies: 2 Size: 79 KB

vm_configuration_webandema
Copies: 9 Size: 88 KB

vm_resource_monitor.png
Copies: 5 Size: 20 KB

vsforwindowsphone.png
Copies: 21 Size: 101 KB

windowsononedisplay.png
Copies: 25 Size: 95 KB

windowsontwodisplays.png
Copies: 25 Size: 86 KE

|| Parallels

Free Memory

Use this tool to release inactive memory and optimize memory consumption on your Mac.

1
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ZIP

0053_04_06_PMA_and_PDFM_localized.zip
fUsers Is/Dact it lels products/PDfM/v13/GUI localization/for PD13 U3 Hi/localized

0053_04_06_PMA_and_PDFM_localized.zip
i | llels/Doct ts/Parallels products/PMA/GUI lecalization/request from sandro_03_04_...

Total size: 61 KB

Launch Free Memory from the Parallels Toolbox window.
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At the bottom of the Free Memory tool you can see the apps that use a significant amount of
memory.

Free Memory

0,02 GB

Available Memory

| ]

(] App memory
@ Wired memory
@ Compressed memory

Available memory

Total memory

Significant Usage:

|| Parallels

2 C(Click Free Memory.

Tip: To always see how much memory is available and release inactive memory with just a few clicks,
drag the Free Memory tool to the macOS menu bar. If you need to remove Free Memory from the menu
bar, press the Command key and drag it out.
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Get Help

For more information and support using Parallels Toolbox:

1 Click B in the macOS menu bar.
2 Click % and choose Help > Support Center.

There you can find answers to common questions, and you can contact Parallels Support for help.

Tips and Tricks

You can also get helpful tips and tricks for using Parallels Toolbox by clicking B4 in the menu bar. A
tip appears at the bottom of the window. Click the tip to see another tip. If you don't see any tips in
the Parallels Toolbox window, click ﬁ, select ¥ > Preferences >General and make sure Show
the "Tips and Tricks" section is selected.

Tip: To learn more about any tool, move the pointer over the tool and press the Space bar. A window
opens with information about the tool.

&

Archive Unarchive

Q #* [

oy

Use Archive o creata compressed archives from your files, to save space or easily

share multiple files. Archive has more capabilities than a buit-in system utility. You

can craate password-protected archivas, so only those who know the password

can access the archived files. You can create an archive with several files from

various locations simply by launching Archive from Toolbox or the Finder and

dragging files and folders to its window — no need to move or copy files toa

single folder.

Enable password option and tha tool asks you to provide a password when &
creating an archive. You can even specify a default password, so subsequences
archives yvou create are automatically set to use that password.

Password: No

Tips and Tricks
+ You can create archives by dragging files and folders to the Archive icon in
the Finder or Dock
» Make a duplicate of Archive in the Finder and set a predefined password
to quickly create password-protected archivas



Get Help

Suggest a Feature

Have an idea for a great feature for Parallels Toolbox? You can share it in the Feature Suggestion
forum. And you can also vote for features that other users have suggested.

To access the forum:

1 Click &4 in the menu bar.
2 Click % and click Suggest a Feature.

In This Chapter
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Check for Updates

Periodically, Parallels provides free updates to improve Parallels Toolbox. If an update is available, it
is automatically installed.

To check for updates manually:

1 Click ™4 in the macOS menu bar.
2 Click % and click Check for Updates.
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